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Overview 

Notes for this Document 

 This document is intended for all RMTrack users. RMTrack also publishes an 
Administration Guide which is intended for RMTrack administrators. However, any 
RMTrack user may benefit from reading both as certain features and functionality 
are explained in only one of the guides. 

 Help pages are available within the application on every RMTrack page by clicking 

on the Help link located at the top left of each page. The User, Administration and 
Reporting guides are also available on-line from Help by selecting Help  Contents 
 Documents. 

 Issues and Projects are two terms used throughout this document. Issue refers to 

the detail level of information. An issue can be thought of as one item or record 
within the application. Project refers to a group of issues linked by some common 
factor for example issues for a certain client or issues for a certain product. One 
of the features of RMTrack is the ability to change the naming for Issue and 
Project. For example the name for Issues might be changed to Defects, Bugs or 
Tasks and Projects might be changed to Clients or Products. The decision and 
ability to change these names is made by the site administrator. This document 
does not reflect any custom name changes made to a specific installation. 
Therefore, users may not see the word Issue or Project in their installation.  

 Issue Numbering is another configurable feature of RMTrack. By default RMTrack 
numbers each issue uniquely across all projects i.e. Issue number 1 will only 
appear in one project. This is the issue numbering style presented in this 
document. Site administrators may choose to alter the issue numbering to 
‘sequentially within each project’ i.e. each project will have an issue 1, for 
example P1-1 and P2-1 where P1 and P2 are project prefixes assigned by the 
administrator. 

 Please report any errors or discrepancies you may find in this document to 
support@rmtrack.com. Your assistance is appreciated. 

  

mailto:support@rmtrack.com
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New with V4.0 

Features and Usability 

Complete lists of bug fixes, usability changes and new features are available from: 
HelpContentsReadMe under the New Features & Enhancements section. 

Release notes for all versions and releases of RMTrack are also available from the 
download page of our website: www.rmtrack.com/downloads.  

The following list contains some new feature and usability additions of special 
interest in V4.0 and where to find them in this document. 

New Features Reference List 

Strong passwords/New password setting page............................................... 9 
New layout designer .............................................................................14 
Improved Full-Text Searches ...................................................................19 

New method of downloading ActiveX Controls ......................................... 26,10 
 

 

 

 
 

http://www.rmtrack.com/downloads
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Getting Started with RMTrack 

A Note from RMTrack Support 

RMTrack offers full pre and post-sale support for our application. We are happy to 
answer any questions you have and offer any assistance required to introduce you to 
the application and to assist with configuring RMTrack to meet your specific needs. 

RMTrack Support has years of experience in a variety of businesses and have assisted 
in the configuration of hundreds of RMTrack installations. 

Please call or e-mail RMTrack Support to request assistance, guidance, on-line 
meetings … anything you need to get the most from RMTrack. 

Overview 

RMTrack was originally designed as an issue tracking application for use in software 
development. While RMTrack was always designed to be customizable to meet the 
needs of individual clients, over the years we have expanded the customization 
features allowing RMTrack to be used in many different ways and to track many 
different types of “items”. The best description of RMTrack now is: 

“A web based application that allows a group of users to 
collaboratively manage items though a workflow process. Information 

about these items can be entered and updated throughout the 
process. Accountability is maintained by assigning each item to an 

individual user at each step of the workflow.” 

Glossary of Terms 

 Issue – the default term used for an “item” or single record in RMTrack. This default can easily be 

changed to reflect the items being tracked e.g. Bug, Lesson, Article, Request, etc. 

 Project – the default term for a group of like issues. For reporting and for user access it is often 

desirable to group like items together. Again, this default term can easily be changed e.g. 
Customers, Regions, Categories, etc. 

 User – an individual that has been granted access to the RMTrack application. Users are granted 

access using logon credentials (user Id and password). Access can also be granted using Windows 
Authentication. Each user can then be granted access to one or more Projects and is made a 
member of one or more Groups. 

 Group – groups are used to group together similar types of users (or ‘roles’), for example 

Developers, Analysts, Managers. These groups are control the assignment rules for the workflow 
process. For example an issue that is sent for “Approval” must be assigned to a member of the 
“Managers” group. Groups can also control what items a user has access to and what information 
on each item they can access. 
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 User Security Type – each user is a member of a particular security type which controls what 

features the user has access to. RMTrack predefines Site Administrators, Regular Users and Public 
Users but more types can be added. 

 Workflow – describes the process (or path) that an item follows while being tracked. Normally 

this process goes from creation to completion but some workflows are cyclical in nature, for 
example a maintenance schedule. Each project can have a different workflow i.e. a different 
process. 

 Resolution – is a “step” in the workflow process. In RMTrack a resolution is represented as a box 

on the workflow diagram. 

 Status – in RMTrack this is either OPEN or CLOSED i.e. Active or Inactive. The combination of 

status and resolution is referred to as the Resolution State. For example an item could be 
“Resolved – Open” or it could be “Resolved – Closed”. 

 Transition – is the movement from one resolution state to another. In the RMTrack workflow 

diagram a transition is represented as an arrow. Transitions can be manual (i.e. a user moves the 
item) or automatic (i.e. the application moves the item based on elapsed time or the passing a 
certain date). 

 Fields – are the individual pieces of information tracked about a particular item e.g. Summary, 

Description, Due Date, etc. You can create as many fields as you need to track you items. RMTrack 
allows for several different types of fields: Text, Date and Time, Dropdown list, Numeric, Checkbox 
(yes/no), Comment Log and Computed. 

 Data Entry Form – is the collection fields associated with an item. Each project can have a 

different set of fields i.e. a different Data Entry Form. 

 Code Tables – are a list of values used by a dropdown type field. The code table for a dropdown 

must be created before the field is created. 

 Outgoing E-Mail (or E-Mail Notifications) - RMTrack has the ability to send an e-mail when any 

action in the workflow occurs. For example, when the Assignment of an item changes e-mail the 
user that is no assigned the item. RMTrack allows for multiple e-mail notification rules to be 
created and each project can have its own rules. Each e-mail rule can have its own e-mail template 
that is used to formulate the e-mail. These templates can include data from the item fields. 

 Incoming E-Mail – RMTrack can monitor multiple e-mail addresses and automatically create 

items when e-mails are received. 
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Logging In  

NOTE: Your installation may be using an integrated login to access the RMTrack application. 
In that case, you will not see the following login page but will be taken directly to the Issue 
List page. 

To begin using RMTrack an administrator needs to create your user profile and provide 
you with your log in credentials. Enter your username and password and then click the 
Login button.  

 

Keep me logged on  

Selecting this option will override the standard 20 minute timeout for inactive 
sessions and keep you logged into RMTrack. 
 
For users with Named user licenses (i.e. dedicated to the user), this option is 
effectively the same as using ‘remember me’ on many web sites – their sessions will 
not timeout  and when they access the application they will by-pass the login page. 
 
For users with Floating user licenses (i.e. shared licenses), this option will attempt to 
keep the user logged in. However, a user may lose their license spot if another 
floating license user tries to logon and the ‘keep me logged in’ user has been idle for 
longer than the session time out parameter. 

WARNING: Allowing and using ‘Keep me logged in’ can weaken the security of the 
application as workstations left unattended could be used by unauthorized people to access 
the application. 
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Forgot your password 

If you forget your password click on the Trouble logging on? Forgot your password? 
link to recover your password. RMTrack supports two types of password recovery. 
Depending on how your site is configured you will either be prompted with a Secret 
Question that you must have previously created an answer for or you will be asked for 
your e-mail address in the RMTrack site and will be sent an e-mail to that address 
with a link to reset your password. 

Don't have a user id? 

Projects in RMTrack can be set up as Public Access projects. When a public access 
project exists within the database, new users can create their own public access user 
id by clicking on the Sign up for one here link. If there are no public access projects 
in your RMTrack installation, this option will not appear. For more information on 
Public Access Projects please refer to the Administrator Guide. 
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My Info 

The My Information page in RMTrack allows individual users to update personal 
information for their user accounts 

Name and E-Mail 

You can change your name and e-mail address as required. Each user also has the 
option to opt out of receiving RMTrack e-mail notifications by unchecking the E-Mail 
Notifications checkbox. 
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Log-In and Security 

Change your password 

Clicking this link will take you to page where your password can be changed.  

 

You will be required to enter your existing password before entering your new 
password. Your site administrator controls whether there are any password strength 
requirements. If there are strength requirements they will be listed beside the New 
Password field. 

Change you secret question and answer 

Clicking this link will take you to page to change your secret question and answer. 

NOTE: Some RMTrack installations may choose to use an e-mail password recovery method 
instead of a secret question. If e-mail password recovery is used you will not see this 
option. 

 

After confirming you password you will can choose a new question and answer. Some 
installations may not allow you to create your own question in which case you must 
choose one from the list. 
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Preferred Time Zone 

All dates and times in RMTrack are stored in UTC (Coordinated Universal Time). When 
dates and times are displayed in RMTrack they are adjusted to each user’s Preferred 
Time Zone.  

Out of Office 

The Out of Office setting allows the user to temporarily not have issues assigned to 

them. By selecting the Issues assignments will not be accepted option, no issues can 
be assigned to this user. If another user attempts to assign an issue to an Out of 
Office user an error will occur. The error message appears at the top of the issue 
page:  

Please correct the following error  

 User userid is 'Out of Office' and cannot be assigned issues (user's message: message) 

You can include a message to be displayed when new assignments are rejected. For 
example, you may wish to include the user id or name of the person covering for you 
while you are away. 

Download ActiveX (button) 

Users that belong to a Security Type that allows the use of ActiveX Controls can re-
download the Controls here. Please see the section on ActiveX Controls in this guide 
for more information. For more information of Security Type settings, please refer to 
the RMTrack Administration Guide. 

Clear Cookies (button) 

This button will clear any browser cookies associated with RMTrack on this computer. 
These can include a Keep me logged on cookie, and an ActiveX Control version 
cookie. If you are experience problems with ActiveX Controls or Keep me logged in 
please use this button to clear the cookies. If you continue to have problems, contact 
your site administrator or support@rmtrack.com.  

mailto:support@rmtrack.com
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Working with the Issues List 

The My Issues page is where you land after logging in to RMTrack. From this page you 
can view and open any issues that you have been granted access to.  

By adjusting the Project, Filter and Layout at the top of the page you can customize 
your view to specific projects, specific issues and specific fields.  

Clicking the Issue # link on an issue you will take you to the Issue Details page for 

that issue. 

 

Sorting 

The list of issues can be sorted by clicking on the column heading. Clicking on the 
heading a second time sorts in the reverse direction. The small triangle displayed at 
the end of a column title indicates that the list is currently sorted by this column and 
the sort direction. 

The default sort order for the page is controlled by the selected Layout. 
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Filtering 

The Project and Filter dropdown lists allow you to filter the list of issues. By 
selecting a specific project only issues for that project will be shown. The Filter 
dropdown displays a list of all the filters available to you. There is a set of default 
filters available and you can create and publish (share) your own filters.  

Basic Filters 

Filters allow the My Issues list to display only issues you are interested in. You can 
select a filter to use from the Filters dropdown on the My Issues list page. This drop 
dropdown will contain: System filters, published filters, personal filters and New 
filter…  

RMTrack comes with several system defined filters: Assigned to X (where X is a team 
member), Open Issues and All Issues. You can also create your own filters by 

selecting New filter… from the filters dropdown. These filters can be published to 
other users (shared) or remain private. Published filters will show the user id of the 
owner of the filter in brackets after the filter name e.g. Opened Today (by jdoe). 

To modify a filter first select it from the dropdown, then click on the Filter: label. If 
the filter you have selected is a system filter or a published filter owned by another 
user you will be asked if you would like to make a copy of it. This allows you to 
modify system and published filters and save them as your own.  

To create a new filter first select a value from the Field dropdown, then select a 
Condition (e.g. contains, between, etc.) and then select a Value. Finally click Add to 
list to add that new condition to the Criteria. A filter can contain multiple lines of 
selection criteria joined by And or Or operators. Filters also support the logical 
grouping of conditions using brackets and the Not condition. 
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To modify a line of the criteria, select the line in the list and click Modify, then 
change the field, condition or value and when satisfied with your changes click 
Update. 

Each filter must be given a name and each filter must have a publishing setting. A 
filter can be private i.e. published Only to me. Filters can be published to your team 
members i.e. users that belong to any of the same projects as you and filters can be 
published to all users (except Public users).  

Filters can also be published for use by users of specific projects by using the To 
users viewing these specific projects: option and selecting the desired projects from 

the dropdown. These filters will only be displayed in the dropdown list of available 
filters when one of those projects is selected in the Project dropdown. 

HINT: When including a User field in the filter (i.e. Created by User or Assigned to User), 
the list of values will contain @CurrentUserID. This is especially useful for published filters 
so they will work for whichever user is logged on and using the filter. 

By clicking on Filters List… at the top of the page, you will be shown a list of all your 
filters. You can modify these filters by clicking on them, or delete filters by checking 
the checkboxes beside them and then clicking the Delete button. The filter list also 
indicates the publishing setting for each of your filters. 
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Advanced Filters 

There may be occasions when a desired filter cannot be entered by the above 
method. Checking the Advanced filter box replaces the filter building wizard with a 
free form text field.  

Enter the filter expression as the WHERE condition of an SQL SELECT statement. If 

you are looking for any issue with a module code of Administration the filter 
expression will be: Issues.ModuleCode = ‘Administration’. 

Note: Advanced filters require some knowledge of databases and the SQL query language. 
For assistance creating advanced filters please contact support@rmtrack.com.  

Layouts 

Layouts control which fields are shown in the My Issues list. When you first begin to 
use RMTrack the My Issues page will use the site default layout created by your site 
administrator. You can also create your own layouts by selecting New layout… from 
the layout dropdown. These layouts can be published to other users (shared) or 
remain private. Published layouts will show the user id of the owner of the layout in 
brackets after the filter name e.g. Customer details (by jdoe). 

A layout can be private i.e. published Only to me. Layouts can be published to your 
team members i.e. users that belong to any of the same projects as you and layouts 

can be published to all users (except Public users).  

Layouts can also be published for use by users of specific projects by using the To 
users viewing these specific projects: option and selecting the desired projects from 
the dropdown. These layouts will only be displayed in the dropdown list of available 
layouts when one of those projects is selected in the Project dropdown. 

To modify a layout first select it from the dropdown, then click on the Layout: label. 
If the layout you have selected is the default layout or a published layout owned by 
another user, you will be asked if you would like to make a copy of it. This allows you 
to modify default and published layouts and save them as your own.  

To create layouts select New Layout… from the layout dropdown list. To examine or 
modify the currently selected layout click on the Layout: label. You cannot change 
the site default layout or layouts created and published by another user but you will 
have the option of copying those layouts and modifying the copy. 

mailto:support@rmtrack.com
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The data fields displayed on the My Issues page is determined by the fields shown in 
the Displayed Fields section of the layout designer.  

To change a layout select a field from the Available Fields list and then move it to 
the Displayed Fields list by clicking the .    arrow. Fields in the Displayed Fields list 
can be removed by selecting them and clicking the       arrow. The order of Displayed 
Fields can be changed by using the up       and the down       arrows. A new display 
row can be added to the layout by clicking the       and rows can be removed from the 
layout by clicking the      . 

Depending on the site options chosen by your site administrator, you may have the 

option to insert a special field called Attachment Thumbnails into your layout. Any 
image files (i.e. .JPG, .BMP, .GIF) attached to an issue will display a thumbnail image 
of the attachment in the My Issues list. Non-image type attachments will not be 
displayed at all. Attachment thumbnails must be on the last line of the layout and 
must be the only field on the line. 

You can choose which field the My Issues list will be sorted on by using the Sort Order 
dropdown. The direction of the sort is determined by selecting the Descending 
checkbox or leaving it blank (Ascending). An alphanumeric sort is used unless the sort 
field for the layout is a code table field (dropdown list) that uses a sort order of its 
own (please refer to the section on Code Tables in the Administration Guide for more 
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information).  Any issue field may be selected as the sort field regardless of whether 
or not it appears in the layout. 

By clicking on Layouts List… at the top of the page, you will be shown a list of all 
your layouts. You can modify a layout by clicking on it, or delete layouts by checking 
the checkboxes beside them and then clicking the Delete button. 

Mass Reassign 

The intended use of the Reassign button is to allow a group of issues to be reassigned 
to a different Assign to user or a different Resolution or Status, quickly.  

If one or more issues are selected by checking the box to the left of the issue, the 
Resolution, Assign to, and Status dropdowns become enabled. Choose the desired 
values and click the Reassign button to update the selected issues. You can only 
select issues that you have the ability to update. Checking the box at the top beside 
Issue # will select all issues in the list you can update. 

Mass reassign will enforce all workflow and assignment rules for the issues. Any issue 
that cannot be reassigned due to these rules will be left in its original state; all others 
will be reassigned. 
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Issue List Page Options 

When viewing the My Issues list page there are Page Options available from the left 
side menu bar. Three of these are standard RMTrack options: 

Settings… 

You can customize certain display features and defaults of your My Issues page by 
clicking the Settings… menu choice under Page Options.  

 

You can select a default Project to display when you view the My Issues page. The 
New Issue page will also default to this Project. 

You can set the number of issues to display per page of the My Issues list. Higher 
number of issues will take longer to load. 

You can choose a Default Filter and Default Layout for the My Issues page by 
selecting them from the appropriate dropdowns. You can also choose whether you to 
want see system generated and published filters and layouts in the dropdowns by 
checking the appropriate checkboxes. When you have finished customizing your page, 
click Save. 
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This page also allows provides a path to maintain your personal custom Filters and 
Layouts. By clicking on the Filters… or Layouts… buttons you will be shown a list of 
layouts or filters that you have created. To modify a filter or layout click the name of 
the one you wish to modify. Please refer to the sections on Filters and Layouts.  To 
delete a filter or layout, check the names you wish to delete and then click Delete. 
Clicking the New button will allow you to create new filters and layouts. 

Download… 

You can download the list of issues as a comma separated data file (.csv) suitable for 
use with MS Excel or other applications. This can be very useful for reporting, or 
loading RMTrack data into other applications. 

All issues selected by the Project and Filter dropdown choices will be downloaded. 
All fields displayed by the currently selected Layout will be downloaded. Once the 
desired Project, Filter, and Layout have been chosen, download the issues by clicking 
the Download… menu choice under Page Options.  

You will be then be prompted to choose whether to open the file from its current 
location or save the file to disk.  

NOTE: By selecting Project: All Projects, Filter: All Issues, and creating a Layout that 
contains all issue fields, it is possible to download all issue information from RMTrack (with 
the exception of attachments). 

Printer Friendly… 

The list of issues can be displayed in a printer friendly format with no top or left 
menu structures and links disabled. Once the desired Project, Filter, and Layout 
have been chosen, click the Printer Friendly… menu choice. This will open a new 
browser window containing the information appropriately formatted for printing or e-
mailing.  Use your browser options to print or e-mail the pages. 
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Searching for Issues 

Often the best way to find specific issues in RMTrack is to use custom filters on the 
My Issues page. A custom filter allows you to define a very specific query on specific 
fields to locate issues you are looking for. 

RMTrack also provides a Search page for locating specific issues based on Issue # or 
by Searching for phrases that match text issues fields. The search page is displayed 
by clicking on the Search choice in the left menu.  

RMTrack can be configured to search the database in either of two ways: 

Specific Phrase  

This will search the database, field by field, for the specific phrase entered in the 
Search for Phrase field. The search must find an exact match to this phrase to return 
results. You can use an asterisk (*) as wildcard for searching. For example, searching 

for problem*logon will match on the phrase “A problem was found with the new 
logon page”. 

Full-Text 

RMTrack installs with Full-Text Indexing disabled. We recommend enabling Full-Text 
Indexing to improve the efficiency and usability of the RMTrack Search page. If the 
description beside Search for phrase on the Search page includes the text “…use * for 
wildcard…” then your RMTrack site is not using Full-Text Indexing.  

We recommend you discuss enabling this option with your site administrator. For 
more information on Full-Text Indexing please see the section Site Options in the 
Administration Guide. 

Full-Text searches are more like internet searches and will search for each word in 
the Search for Phrase separately. The search will return a ranked list of results 
where the higher the rank the more likely a match it is.  

Phrase matching in RMTrack is done on a field-by-field basis - not across the entire 

issue all at once. If the phrase matches a single field on an issue then that issue will 
be included in the results. Each individual comment entry is treated as a separate 
field and each individual history record is treated as a separate field. History records 
are ranked lower for matching purposes than other fields and comments. 

Multiple words (AND) search: Each word in the search phrase must be present in any 
single field of the issue. For example, searching for the phrase: problem logon will 
return all issues that have at least one field that contains both the word problem and 
the word logon.  

NOTE: The RMTrack search uses an implied "and" in multiple word searches. The search 
phrase logon problem translates to logon AND problem. 
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Exact phrase search: You can use double quotes to search for an exact match of 
words. For example a search phrase of: “problem with logon” will only return issues 
that contain the exact phrase problem with logon in some field on the issue. 

Either (OR) search: You can use OR (capital letters) to search for either of two (or 
more) words. For example a search phrase of problem OR logon will return all issues 
that contain the word problem or that contain the word logon. 

Exclude word searches: You can use the minus sign to exclude results. For example a 
search phrase of problem –logon will return all issues that have at least one field that 
contains the word problem and does not contain the word logon. 

Partial word (*) match: The asterisk character (*) can be used as a wildcard character 
to match on any sequence of characters at the end of a word. For example a search 
phrase of: log* will return all issues that contain the words logon, login, logout etc. 
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Working with Issue Details 

The Issues Details page displays either a new issue or an existing issue.  

By default only the Assign to: user can update an issue. Depending the configuration 
of the installation, all users may be able to add comments and attachments. Certain 
groups may be restricted from viewing or updating some fields. If you are restricted 
from updating a field the field will be disabled and grayed out. Site Administrators 

and Project Administrators (for their projects) can always update all fields of an issue 
regardless of who it is assigned to. 

Creating a New Issue 

To create a new issue, click New Issue at the top of any RMTrack page. Enter the 
issue details by selecting the desired values from drop-down lists, entering the 
appropriate text, selecting dates, etc.  

Some fields may be mandatory, as determined by the workflow rules. These will be 

indicated by a red asterisk (*) beside the field’s name. You will be prompted if any 
required fields have been left blank.  
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Updating an Issue 

Project and Site Administrators can update all fields in any issue. Depending on the 
security levels granted to your user id and the security settings for the user group(s) 
you are a member of, you may not be able to update anything on issues that are not 
assigned to you. 

If you are the assigned user of an issue you can update any field values as long as the 
group(s) you belong to are not restricted from updating those fields. Depending on the 
setting of the Resolution and Status fields different validations are enforced by the 
workflow rules. Required fields will always be shown with a red asterisk (*) beside the 
field’s name. 

Resolution, Assign To, Status 

All issues have a Resolution, an Assign to, and a Status. The possible values for these 
fields are derived from the workflow configuration. Users are only provided with 
choices that meet the workflow rules, unless they have been granted Override 
Workflow privileges by an administrator. 

Issue Details Page Options and Tools 

When viewing the Issue Details page there are Page Options available from the left 
side menu bar.  

There are also tools available on the right side of the page. 

Issue Subscription… 

On the Issue Details page, under the Page Options is a Subscribe…/Unsubscribe… link. 
Any user can subscribe to an issue even if they are not currently assigned to it. Once 
subscribed, you will receive an email notification whenever the issue is updated. This 
feature may be deactivated by your site administrator. 

Note: The Subscriptions options are controlled as a site option and at the group security 
level and may not be available on your issue page. 

Printer Friendly… 

On existing issue details, under the Subscribe… link is a Printer Friendly… link. 

Clicking this link opens a new page with a printer friendly version of the issue details 
suitable for printing or emailing. This feature is also useful for viewing any comment 
fields contents all at once. 
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Navigation 

At the top right of the page are navigation links Prev Issues Next to allow you to 
move between the issues displayed by the My Issues page, the Search Results page or 
the Release Notes report. 

Attachments 

Note: The ability to add and view attachments on an issue is controlled at the group 
security level therefore you may not have access to this feature, you may only have view 
access, you may be able to add attachments only to issue that are assigned to you, or you 
may be able to add attachments to all issues. 

Below the navigation links is the list of any files attached to the issue. Clicking on the 
name of the attachment will download the attachment to your browser. How the file 
is opened and restrictions on downloads are controlled by your browser.  

 

You can attach any type of file to an issue by clicking on the New… link located to the 
right of the Attachments heading. From here you will be taken to a page where you 
will be able to browse for the file(s) you wish to attach. If you have Flash or 
Silverlight installed you can select multiple files to attach by holding the Ctrl key and 
clicking on each file name. After clicking the Open button in the file browser the 
selected files will be uploaded to your browser. For example: 

 

Click the Attach button to complete the attachment process.  
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The default maximum size for an attachment is 10MB but this setting may have been 
changed by your administrator.  

To delete an attachment select it using the check box beside the attachment name. 
Clicking on DEL will delete it immediately. Or selected attachments will be deleted 
when the issue is saved.  

Depending on the site options chosen by your RMTrack administrator, image files (i.e. 
.JPG, .BMP, .GIF) attached to an issue may display a thumbnail image of the 
attachment. 

Subscriptions 

Note: The ability to add and view subscriptions on an issue is controlled at the group 
security level therefore you may not have access to this feature, you may only have view 
access, you may only be able to subscribe yourself to issues or you may be able to 
subscribe other users to issues that are assigned to you. 

Below the Attachments section is a list of users currently subscribed to this issue. 

 

If you are able to modify the subscription list new subscribers can be added by 
clicking the New… link. 

Users can be removed from the Subscriber list by checking the box beside the user id. 
Clicking on DEL will delete it immediately or, selected users will be deleted when the 
issue is saved.  

 

Clicking on a user id in the subscription list will present the option to enable or 
disable email notifications for that user.  
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Related Items 

Note: The ability to view and add related items is controlled at the group security level. 
Some users may not be able to add or see related items. 

Below the Subscriptions section (or Attachments section if the subscription site option 
is not turned on), on the right side of the Issue Details page is the Related Items 
section. Related items are links to information related to this issue.  

 

You can create a related item entry by clicking on the New… link. 

To delete a related item, select it using the check box beside the item name. Clicking 
on DEL will delete it immediately. Or selected items will be deleted when the issue is 
saved.  

 

There are two types of related items: 

Related Issues – Entering a valid issue number will create a link to that issue. It will 
also create a link on the target issue back to the current issue. Deleting the link from 
either issue will remove it from both issues. Users can only create links to issues that 
they have access to based on their project and group membership. If links are present 
to issues that a user does not have access to they will not be displayed to that user. 

Uniform Resource Locator (URL) – URL’s can be entered as related item links on an 
issue. URL’s can point to a web site or files located on a network server. When the 
related item link is clicked it can open in a new browser window or re-use the open 
one. You can also provide a meaningful name (display title) for the link.  
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Issue History 

Note: The ability to view Issue History is controlled the group security level. Some users 
may not see the issue history. 

Below the Related Items section is the Issue History section. Each time an issue is 
saved, RMTrack will create a history record logging the changes to the issue. These 
history records appear in reverse date order. 

 

Each history entry shows the date and time that the issue was last saved and the user 
id that saved it. It also shows the resolution, assigned to, and status at the time of 
saving. Each history entry also has a details… link to the full audit history record. 
Clicking on this link will open a new Internet explorer window with the full audit trail 
details for that save of the issue.  

NOTE: Field level security restrictions may prohibit access to the history details. If your 
group membership restricts you from viewing certain fields, you will not be able to access 
history details and the details… link will not be displayed. 

ActiveX Controls 

RMTrack includes a screen capture feature only available to IE users with RMTrack 
ActiveX Controls installed.  

Users that belong to a Security Type that allows the use of ActiveX Controls will be 
prompted to download the Controls the first time they view the Issue Details page. 
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PC/User security settings need to allow Signed ActiveX Controls to be installed on the 
PC.  

Once the ActiveX Controls have been downloaded to the PC, users on that PC will not 
be requested to download again unless cookies are cleared or the ActiveX Controls are 
updated on the server i.e. a new release of RMTrack. 

If the user chooses the Run without the ActiveX Controls option from the above 
screen, they will not be prompted to download them again. At any time users that 
belong to a Security type that allows ActiveX Controls can re-download the Controls 
from the My Info page under Administration in the left side menu.  

RMTrack Screen Capture Tool 

Note: This feature is only available when accessing RMTrack with an Internet Explorer 
browser and with RMTrack ActiveX Controls installed. Also, the ability to add attachments 
to an issue is controlled at the group security level therefore you may not have access to 
this tool. 

At the bottom left of the Issue Details page for both new and existing issues, is 
the RMTrack Screen Capture Tool icon. Use this tool to capture screen images, 
make notations on the image and then attach it directly to the issue.  
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Click on the icon to minimize the RMTrack browser window and drag the icon to 
window you want to capture. A thick black line will highlight the border of the area 
that will be captured. When you release the mouse button, the RMTrack window will 
be restored and a new window will open with the captured screenshot in it.  

Annotations can be added to the screenshot to highlight points of interest. Click on 
the screenshot and drag to create a notation box. Background and text color can be 
changed with the controls at the top left of the window. Save the image and/or 
upload the image as an attachment to the current issue. 

Below is a screen capture of a screen capture of the RMTrack website. Note the 

yellow annotation boxes.  
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Working with Reports 

The main reporting tool in RMTrack is the My Issues page described earlier in this 
guide. By defining a custom filter you can report on the exact issues you want. By 
defining a custom layout the exact the fields you need are displayed. The Printer 
friendly… function allows you to print or e-mail the list of issues. The Download… 
function allows you to export the data to Excel for further processing. 

There are 4 stock reports reports available including; Daily Summary that 
summarizes a project team’s activity, Release Notes that details what issues have 
been addressed by a particular build, Summary Trends that shows how the project is 
operating over time, and Issue Distribution summarizing issues by the various codes 
(build, module, etc.). 

Note: Report access is controlled at a User Security Type level and you may not be able to 
see some reports. 

Users belonging to a group set as restricted access (i.e. only able to see issues they created 
or were assigned to) will not have access to the Daily Summary report or the Release Notes 
report. 

Custom Reports 

RMTrack administrators can define custom reports for their installations. Custom 
reports are very flexible and can report on any data in the RMTrack database. Please 
refer to the Reporting Guide for complete details. 

Custom reports can be published a group level allowing some user access to some 
reports but not others.  

Stock Reports 

Daily Summary 

The Daily Summary report helps teams stay on top of project activity. Select to view 
the activity for one project or for all projects. Select to view all of yesterday’s, 
today’s, this week’s, last week’s, last month’s or this month’s activity. 

The report summarizes activity by each team member. There is a checkbox that can 
be used to eliminate users with no activity for the period chosen. Clicking on the plus 
sign located beside the team member’s name will expand each team member’s 
activity. Once expanded, the report will display a list of the issues worked on by the 
team member using the layout of your choice from the Layout dropdown list.  
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Release Notes 

The Release Notes report details issues that have been addressed, or not addressed, 
by a particular build. The “Detected in Build”, “Resolved in Build” and “Verified in 
Build” fields are keys to this report’s accuracy. This report will only be available if 
your installation of RMTrack uses the default build code fields installed with RMTrack: 
Detected in Build, Resolved in Build and Verified in Build. 

Select the Project, the Build being released, and the Previously released build to 
display the report.  

The report has two sections: “Fixed Issues” and “Known Issues”. Each section of the 
report will display using the layout chosen from the Layout dropdown list. Each 
section can be independently sorted by clicking on the column headers. The entire 
report can be printed, or e-mailed, using the “Printer friendly…” option at the bottom 
left. Each section of the report can be downloaded using the “Download X…” menu 
choice at the bottom left. 

The criteria used for determining Fixed Issues is: 

Valid = Yes    
and Fixed = Yes 
and Detected In Build <= Previously Released Build 
and Verified In Build > Previously Released Build  
and Verified In Build <= Build Being Released 
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The criteria used for determining Known Issues is: 

Valid = Yes     
and Fixed = No  
and Detected In Build < Build Being Released     
and Status = 'Open' 
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Summary Trends 

The Summary Trends report is a graphical representation of project progress. Each 
project can be measured by examining the number of new issues being logged vs. the 
number of issues being closed over time. 

To view the report, click on the “Summary Trends” choice in the left menu. Use the 

dropdowns at the top of the page to select the project and the desired time-period. 
The graph will always show “Total Open Issues”. In addition, the following 
information can be placed on the graph by selecting it from the “Add” button on the 
right: 

 New Issues 

 Closed Issues 

 Total Closed Issues  

 Total Issues 

 

The Download… link at the bottom left of the page allows the raw graph data to be 
exported to a comma delimited (.CSV) type file. You will be prompted to choose 
whether to open the file from its current location or save the file to disk.  
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Issue Distribution 

This report allows you to examine a project’s issues in a variety of categories. Select 
the project, and from the Graph dropdown list select the desired category to view.  

 

Examples of how the Issue Distribution report can be used: 

 To determine workload. You can quickly see which team members have the 
most issues assigned to them. If one team member is overloaded adjustments 
may be required. 

 To determine module stability. If a module has had more issues logged against 

it than others than this is a strong indication of the module’s stability. 
 
The Download… link at the bottom left of the page allows the raw graph data to be 
exported to a comma delimited (.CSV) type file. You will be prompted to choose 
whether to open the file from its current location or save the file to disk.  
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Understanding Workflow 

Note: To view the workflow diagram using IE8 requires the RMTrack ActiveX Controls to be 
installed (please ActiveX Controls in the Issue Details section for more information). All 
other browsers use an HTML5 version of the diagram. 

Workflow is the set of rules that determine the flow of an issue through the issue 
resolution process. Workflows also determine the rules for what information is 
required and who an issue can be assigned to. Each project can have its own workflow 

and workflows may be used by more than one project. 

Your site administrator will have determined whether you have access to view the 
workflows for your projects. If available, you will have inquiry mode only from the 
Workflow choice in the left menu (under Administration). This will show a list of 
workflows that are used by projects that you belong to. When a workflow is selected 
the diagram loads and the user can double click on the boxes (Resolution States), and 
on the lines between the boxes (Transitions), to see the configuration details and 
rules.  

 

For more information on Workflows please refer to the section on workflows in 
the Administration Guide. 
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Contact Information 

At RMTrack we want your feedback!  Please feel free to contact us, anytime, with 
questions, comments or inquiries:   

General: inquiries@RMTrack.com  

Support: support@RMTrack.com  

Sales:  sales@RMTrack.com  

Web-Site: www.RMTrack.com  

Phone:  416-929-1720 
Toll Free: 1-888-225-2271 (Canada and United States) 
 
Address: RMTrack Issue Tracking Solutions Inc. 
  7 Walmer Road, Suite 1509 
  Toronto, Ontario 
  Canada 
  M5R 2W8 
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